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An Intro

Head of Machine Learning @ ~roton (e.g. Proton Mail)

PV R

Before Proton, | led the Machine Learning team @ Facebook/Meta
on External/Internal defence (Security team).

My background and first love is in data visualisation which is actually
what drove my interest in ML )

My DPhil/PhD is in Computer Science but focused largely on what was
previously called Bioinformatics (now rebranded as Data Science...)
where | built new visualisation techniques.

Worked in Biology, Physics, Finance, and Security, so happy to talk about lots of things :)



Visualization
Analysis & Design

A lot of the content for this introduction comes
from this book from Prof. Tamara Munzner
(UBC, Vancouver, Canada) which | created the
illustrations for.

If you’re interested in learning more, it’s a
great book to check out :)



Visualization

The role of visualization systems is to provide visual representations of datasets that
help people carry out tasks more effectively.

Tamara Munzner

A Visualization should:

Save time
Have a clear purpose*

Include only the relevant content*

NN

Encodes data/information appropriately

* from Noel lllinsky, http://complexdiagrams.com/
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Visualization

The role of visualization systems is to provide visual representations of datasets that
help people carry out tasks more effectively.

Visualization is suitable when there is a need to augment human capabilities
rather than replace people with computational decision-making methods.

Tamara Munzner

A Visualization should:

Save time
Have a clear purpose*

Include only the relevant content*

NN

Encodes data/information appropriately

* from Noel lllinsky, http://complexdiagrams.com/
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Visualization

The role of visualization systems is to provide visual representations of datasets that
help people carry out tasks more effectively.

External representation:
replace cognition with
perception



Visualization

The role of visualization systems is to provide visual representations of datasets that
help people carry out tasks more effectively.

Data Panel

B08

IRAK2
NFKB2
CXCL2
CHUK
IL13
RELA
IKBKB
CCL4
MAP3K7
ICAM1
IRF1
CXCL3
IL12B
CCL11
MAP3K7IP1

Function
Kinase
Transcription factor
Chemokine
Kinase
Cytokine
Transcription factor
Kinase
Chemokine

Adhesion
Transcription factor
Chemokine
Cytokine
Chemokine

Adaptor
Cwvtnkine

LPSLL37_1
2.367
-1.14
1.853
-1.376
-5.961
-1.077
1.167
1.254
1.01
1.184
-1.013
1.7
-2.448
-1.338

LPSLL37_1_pvals
0.251
0.972
0.376
0.373

0.564
0.29

0.878
0.956
0.669
0.519
0.905
0.042
0.349

LPSLL37_2
1.337
-1.03
4.111
2.232
2.139
-1.169
1.421
-1.052
-1.096
1.537
1.416
1.092
-1.473
-1.995

LPSLL37_24
-1.553
1.303
-1.019
1.194
-1.236
1.943
-1.907
1.499
1.222
1.392
1.081
-1.598
-2.109
-1.785

1. N53

=

=

LPSLL37_24_pvals

0.807
0.745
0.387
0.601
0.594
0.286
0.761
0.8
0.671
0.995
0.521
0.08
0.129

N Ss21

[

External representation:
replace cognition with
perception



Visualization

The role of visualization systems is to provide visual representations of datasets that
help people carry out tasks more effectively.

Data Panel T
= External representation:
E=] - P
1D Function LPSLL37_1 LPSLL37_1_pvals LPSLL37_2 LPSLL37_24 LPSLL37_24_pvals 1 1 1
IRAK?2 Kinase 2.367 0.251 1.337 -1.553 replace COg nltlon Wlth
NFKB2 Transcription factor -1.14 0.972 -1.03 1.303 0.807 o
CXCL2 Chemokine 1.853 0.376 4.111 -1.019 0.745 pe Fce pthﬂ
CHUK Kinase -1.376 0.373 2.232 1.194 0.387
IL13 Cytokine -5.961 2.139 -1.236 0.601
RELA Transcription factor -1.077 0.564 -1.169 1.943 0.594 . o . . .
IKBKB Kinase 1.167 0.29 1421 -1.907 0.286 Cerebral: Visualizing Multiple Experimental Conditions
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http://www.cs.ubc.ca/labs/imager/tr/2008/cerebral/
http://www.cs.ubc.ca/labs/imager/tr/2008/cerebral/
http://www.cs.ubc.ca/~barskya
http://www.cs.ubc.ca/~tmm
http://www.cmdr.ubc.ca/~jennifer/
http://rkincaid.net/

visualising? visualise?
Major data types & What is the need How can we
classifications of for this visualize?
them visualization?

The components
Why do the users of a visualization.

need this, and

what do they

need to be able to Good.and bad
do with it? practices.



What are we
visualising?

Major data types &
classifications of
them



What are we visualising??

DATA TYPES
(®) STATIC

DATASET TYPES
(® TABLES

Attributes (columns)

»
L

Iltems

(rows) J T

Cell containing value

= Multidimensional
Table

I )

Key 2

.4— Value

\ in cell
Attributes

ATTRIBUTE TYPES

(® CATEGORICAL

+ O 0 A

(® DYNAMIC
[ ]
®q O o ° —
(® NETWORKS (® FIELDS (conTinuous)
Link Cell B
Node
(item)
Attributes (columns)
—_—
1Valuein cell
> Trees

s

(® ORDERED

= Ordinal

« N

= Quantitative

(® TEXT

= Prose
Documents

@ GEOMETRY (spatiaL)

= Document
Collections

= Log Files
= Code
= Multimedia

= Sequential = Diverging = Cyclic




What are we visualising?

() STATIC

For static data, we have fixed
scales.

We know our data range,
therefore scales will not change.



What are we visualising?

() STATIC

For static data, we have fixed
scales.

We know our data range,
therefore scales will not change.

(® DYNAMIC

For dynamic data, the observed
min and max values can change,
therefore scales will change.

This can have big consequences
for the readability of our
visualization.
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What are we visualising??

The branches of data visualization

50 - CMS

1

8 TeV

" MPF
Simufaton |n| < 1.3
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2350

Information Visualization

Position Is derived.
INncl. GeoVis

We decide what is on the

X

and Y axis, and what we do changes
the information we extract.

Jet 1,

pt = 3.61 TeV
eta = 0.32

phi = 0.64

Jet 2,
pt = 3.38 TeV

—

Scientific Visualization

Position Is given.
e.g. detector or medical visualizations

We have the X, Y, and Z coordinates
of a cell in ATLAS, we show the energy
deposit left here. We don’t choose,

the data tells us.



What is the need
for this
visualization?

Why do the users
need this, and
what do they
need to be able to
do with It?

11



The role of visualisation systems is to provide visual representations of datasets
that help people carry out tasks more effectively.

The statistics would lead us to
believing that everything is the

same

Anscombe’s Quartet: Raw Data

1 2 4
X Y X Y X Y X Y

100 804| 100 9.14| 100 7.46| 80 658

80 695| 80 814, 80 677| 80 576

130 758 | 130 874 13.0 1274 80 7.71

90 881| 90 877, 90 7.11| 80 884

110 833| 110 926 11.0 7.81| 80 847

140 996 | 140 8.10| 140 884| 80 7.04

60 724| 60 6.13| 60 608 80 525

40 426 40 3.0, 40 539/ 19.0 12.50

120 10.84| 120 9.13| 120 8.15| 80 556

70 48| 70 726| 70 642 80 791

50 568| 50 474 50 573, 80 6.89

Mean| 90 75 | 90 75 | 90 75 | 90 75

Variance | 100 3.75| 100 3.75| 100 3.75| 100 3.75
Correlation |  0.816 0.816 0.816 0.816

12 4
10 4

X1

X3

10 12 14 16 18

X4 12
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Every visualisation should be thought of as a product
of what actions the user needs to take to get to their objective (target)

® Use
> Consume
> Discover > Present
| Nl
/ -III II /\/ .,
.1
® Search
Target known
Location o e
known + Lookup
Location @.> Locate
unknown o
® Query

> |dentify > Compare

SIS

& Actions
= Produce
> Enjoy > Annotate

© XN

Target unknown

*le*s  Browse

"@-> Explore

2> Summarise

> Record

\d

>

> Derive

MR- L

14



Every visualisation should be thought of as a product
of what actions the user needs to take to get to their objective (target)

® Use
> Consume
> Discover > Present
| Nl
/ -III II /\/ .,
.1
® Search
Target known
Location o e
known + Lookup
Location @.> Locate
unknown o
® Query

> |dentify > Compare

SIS

& Actions

= Produce

> Annotate

Target unknown

2> Summarise

= Targets

® All Data

2 Trends 2 Qutliers = Features

4

® Attributes

2 One 2> Many
> Distribution > Dependency » Correlation = Similarity
Al - -~
v Extremes
il
® Network Data ® Spatial Data
> Topology 2 Shape
Ak O "
A
> Paths

14



Every visualisation should be thought of as a product
of what actions the user needs to take to get to their objective (target)

® Use
> Consume
> Discover > Present
| Nl
/ -III II /\/ .,
.1
® Search
Target known
Location o e
known + Lookup
Location
oL
unknown Q ocate
® Query

> |dentify > Compare

IS8

g Actions = Targets

® All Data

- Produce 2> Trends 2 Qutliers = Features

> Enjoy > Annotate 2 Record > Derive f\/
@, - L -
e
© v, >

® Attributes

Target unknown > One 2> Many
> Distribution > Dependency » Correlation = Similarity
Browse -
. - 7
"@-> Explore v Extremes
i,
, ® Network Data ® Spatial Data
2 Summarise
- > Topology > Shape
EFEEEETEE
EETEE
A
> Paths

Always keep in mind why you're doing something. If what you create does not show
what you intended, confuses, or misleads, it's time to rethink :) 14



Why are we visualising?

Given a large matrix, or even a large series of numbers, it's difficult for humans to
‘'see’ patterns in the data.

15



Even in this simple example, it is cognitively demanding to read off all the

iInformation.

Home Small
Category Sub-Category Consumer Corporate Office Business
Furniture Bookcases -45.93 -9,300.00 -16,000.00 -7,600.00
Chairs & Chairmats 42,900.00 41,500.10 41,000.00 25,600.00
Office Furnishings 12,000.00 27,500.10 42,000.00 18,600.00
Tables -12,300.00 -35,400.10 -43,000.00 -8,000.00
Technology Computer Peripherals  14,100.56 45,300.00 17,000.00 17,300.00
Copiers & Fax 41,300.00 -28,600.10 29,000.00 68,100.00
Office Machines 51,400.00 180,300.10 39,000.00 36,500.00
Comms (Telephones) 49,700.00 120,400.10 86,000.00 -59,800.00

What is the goal of this representation?

16



We can improve by using ‘pop-out’ to bring attention to negative values.

Home Small
Category Sub-Category Consumer Corporate Office Business
Furniture Bookcases -45.93 -9,300.00 -16,000.00 -7,600.00
Chairs & Chairmats 42,900.00 41,300.10 41,000.00 25,600.00
Office Furnishings 12,000.00 27,300.10 42,000.00 18,600.00
Tables -12,300.00 -35,400.10 -43,000.00 -8,000.00
Technology Computer Peripherals  14,100.56 45,300.00 17,000.00 17,300.00
Copiers & Fax 41,300.00 28,600.10 29,000.00 68,100.00
Office Machines 51,400.00 180,300.10 39,000.00 36,500.00
Comms (Telephones) 49,700.00 120,400.10 86,000.00 -59,800.00

17



Or, adding some additional indicators can provide an idea of intensity.

Home Small

Category Sub-Category Consumer Corporate Office Business
Furniture Bookcases -45.93 -9,300.00 116,000.00 -7,600.0C

Chairs & Chairmats $2,200.00 4130010 41,000.00 25600.00

Office Furnishings 12.000.00 27.500.10 42,000.00 18,600.00

Tables -12,300.00 -35,400.10 -43,000.00 -8,000.0C
Technology Computer Peripherals 14,100.56 45,300.00 17,000.00 17,300.00

Copiers & Fax 41,300.00 28,600.10 29,000.00 68100.00

Office Machines 51,400.00 180,300.10 39,000.00 36,500.00

Comms (Telephones) 49,700.00 120,400.10 86,000.00 -59,800.00



Why are we visualising?

Or, adding some additional indicators can provide an idea of intensity.

Home Small

Category Sub-Category Consumer Corporate Office Business
Furniture Bookcases -45.93 | -9300.90 16,000:00) 7,600.04

Chairs & Chairmats 4290000 4130010 41,00000 2560000

Office Furnishings 112,000.00 12730010 42,000.00 18.600.00

Tables -12,300.04] -35,400H0) -43,000100] -8,000.00]
Technology Computer Peripherals 11410056

Copiers & Fax 4130000

Office Machines 5140000

Comms (Telephones) 49:700.00
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https://www.ipcc.ch/ipccreports/tar/wg1/fig2-32.htm

Sometimes visualization is needed to figure out what the best way
to represent a data set can be..combining analytics, visualization,
and human reasoning.

Data ‘ }7 Jalli. Knowledge
&J .
Model
Generation

This is visual analytics.



Discovery and Exploration

Processing Space

Data Input

Select File

WBROWSE ... ® PREVIEW

CSV Fields Options
Choose fields for clustering

citricacid x chlorides x

pH %  sulphates x  quality x

Scale the chosen fields

Algorithm Definitions & Option:

Algorithms KMean %

Vectorizer

K-Means

K Number

3

Hierarchical Clustering

A

K winequality.csv
A

density x v
N

Visualization Swatchboard

oAl Sn 1
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Search...
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Cluster Dimension Comparison

chlorides citricacid

A .

freesulfurdioxide pH
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Joint Work with llias Koutsakis and Gilles Louppe @ CERN

density
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volatileacidity



How can we
visualise?

How can we
visualize?

The components
of a visualization.

Good and bad
practices.

22



How can you encode information optimally?

===+ Encode Manipulate Facet Reduce
® Arrange
> Express > Separate > Order 2> Change 2> Juxtapose > Filter
. m *.e, ol ’ SESSS 5 SSS=25
—t ‘.-... ‘...l. ‘ . @ o ‘ ‘ . .. ===== "~
> Align > Use > Select > Par’gition 2> Aggregate

2> Navigate 2> Superimpose 2> Embed
® Map <ot . E@
from qualitative and quantitative attributes " o m
> Color 2> Region, Texture, Shape, ... e,
> Hue > Saturation + @ B A
HEN L] ]|
2> Luminance 2 Transparency 2> Motion
TEN E Direction, Rate, Frequency, ...
e ) e °
> Position, Size, Angle, e® &
Curvature, ...
—-ae
ol 2 1))D
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How can you encode Information optimally?

====»- Encode Manipulate Facet Reduce
® Arrange
2> Express > Separate > Order 2> Change 2> Juxtapose > Filter
s R — foee | L g
> Align > Use > Select > Par’gition 2> Aggregate

2> Navigate 2> Superimpose 2> Embed
® Map - ™
from qualitative and quantitative attributes \ o m
> Color > Region, Texture, Shape, ... e,
> Hue > Saturation + @ B A .
HEN L]
> Luminance 2 Transparency 2> Motion
L] L] Direction, Rate, Frequency, ...
o ) e °
> Position, Size, Angle, e® &
Curvature, ...
—e—i
C.ml 1 1))
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How can you encode information optimally?

If we don't follow grammatical rules or spell correctly, the
meaning of text can be |lost.

Data

We want to maximise
information gained

EEEEEEEEE .
> , INEEEEEEN Decoder — 'nsights
S Usert  — 5 Error

We want to minimise
the error

Task

The same applies for visualisations. We can compose
visualisations using a vocabulary (shapes, colour, texture,...),

and a grammar. If we learn these, we can do better when it
comes to communicating visually.



How can you encode information optimally?

The importance of the error perceived in a visualisation must always be balanced
with purpose. Sometimes we don't need to read off exact values, and perceptual
strangeness doesn't really matter - but sometimes it does.

Roboto Font Courier Font

x16152101U0

If this is my password, fine.

If it's a wifi password for a coffee shop, maybe not.
There is confusion between the upper case i and the lower case L.

The distance between the characters can cause error in interpretation, causing
frustration for users, and in this case, unhappy coffee shop customers.



How can you encode information optimally?

The importance of the error perceived in a visualisation must always be balanced
with purpose. Sometimes we don't need to read off exact values, and perceptual
strangeness doesn't really matter - but sometimes it does.

Roboto Font Courier Font

x16152101U0 x16I5210IU0

If this is my password, fine.

If it's a wifi password for a coffee shop, maybe not.
There is confusion between the upper case i and the lower case L.

The distance between the characters can cause error in interpretation, causing
frustration for users, and in this case, unhappy coffee shop customers.



Graphs are like jokes.
If you have to explain them, they didn't work.

Anon.

How can you encode information optimally?

26
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And that's just a really simple low dimensional example

Moreover, all of these visualizations encode the information,
but the decode error (interpreting, comparing, ...) for each graph is different

But, why?
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Our perception system does not behave linearly.

Some stimuli are perceived less or more than intended.
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We have to be careful when mapping data
to the visual world

Some visual channels are more effective for some data types over
others.

How can you encode information optimally?
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Quantitative
Cleveland and McGill, 1983
Heer and Bostock, 2010

MacKinley, 1986
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How can you encode information optimally?

Cleveland & McGill’s Results 1984
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To6: Pie charts have also been studied in more detail recently

It's quite clear that bar charts are a more effective visual encoding here
than pie charts... our visual system Is very good at judging lengths, but
not so much at judging angles and areas.

A B C

https://commonswikimedia.org/wiki/File:Piecharts.svg

How can you encode information optimally? 33
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To6: Pie charts have also been studied in more detail recently

When someone reads or compares values in a pie chart, what are
they doing? Comparing angles, areas, length of arc?

Error (Bias)

Eurographics Association, Goslar Germany, Germany, 91-95. DOI: https://doi.org/10.2312/eurovisshort.20161167

Drew Skau and Robert Kosara. 2016. Arcs, Angles, or Areas: Individual Data Encodings in Pie and Donut Charts. Comput. Graph.
Forum 35, 3 (June 2016), 121-130. DOI: https://doi.org/10.1111/cgf.12888

dIVV0

Robert Kosara and Drew Skau. 2016. Judgment error in pie chart variations. In Proceedings of the Eurographics: Short Papers (EuroVis '16).
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T1/T7: Bar charts are better than areas...

Heer and Bostock 2010 Crowdsourced Results
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T1/T7: Bar charts are better than areas...
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T8/T9: Different aspect ratios for rectangles also result in greater or
fewer errors in estimating
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Aspect ratio is important!

For line charts there is a basic guideline on optimising plot aspect ratio to
have an average angle of 45 degrees from Cleveland et al, 1988.

None,Genre
100 { — (Global_Sales, Action)
50 .
0 L T T T T T T T T
1980 1985 1990 1995 2000 2005 2010 2015
140 1 None,Genre
—— (Global_Sales, Action)
120 -
100 -
80 -
a) -
40 -
20 1
0 .

1980 1985 1990 1995 2000 2005 2010 2015

140 -

120 -

100 -

| = (Global_Sales, Action)

None,Genre

1980 1985 1990 1995 2000 2005 2010 2015

None,Genre
—— (Global_Sales, Action)

1980 1985 1990 1995 2000 2005 2010 2015

Although, like most things, not everyone agrees with this guideline.
INn this case | think it makes sense, you can decide ;)
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HOW

We have to be careful when mapping
data to the visual world

Some data has a natural mapping that our brains expect given
certain types of data

39



Graphical Code

Small shapes defined by
closed contour, texture, color.

Spatially ordered graphical
objects.

Graphical objects in proximity

Graphical objects having the
same shape color, or texture.

Size, position or height of
graphical object

Shapes connected by
contour

Thickness of connecting
contour

Color and texture of
connecting contour

Shapes enclosed by a
contour, a common texture or
color

Nested/partitioned regions

Attached shapes

Natural Mappings

+O WA P

He¥

+, +, Egnm
++++.+ N

Semantics

Object, idea, entity, node.

Related information or a sequence. In a sequence
the left-to-right ordering convention is borrowed
from written language (English, French, etc)).

Similar concepts

Similar concepts

Size, quantity, importance, 2D location

Related entities, path between entities.

Strength of relationship.

Type of relationship.

Contained/related entities.

Hierarchical concepts.

Parts of a conceptual structure.
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https://public.tableau.com/s/gallery/london-bus-map
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https://public.tableau.com/s/gallery/10-highest-grossing-actors-all-time?tab=featured&type=featured

HOW

We have to be careful when mapping
data to the visual world

There are many intricacies of the visual system that must be considered
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The pop-out effect

We pre-attentively process a scene, and some visual elements
stand out more than others.

- Parallel processing on many individual channels

— speed independent of distractor count

— speed depends on channel and amount of difference from distractors
- Serial search for (almost all) combinations

— speed depends on number of distractors
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Parallel line pairs do not pop out from tilted pairs...
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Parallel line pairs do not pop out from tilted pairs...

And not all visual channels pop out as quickly as other. E.g. colour is always on
top. 45



The pop-out effect
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The pop-out effect
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Everyone Else

Tracking calories, exercise and weight worked
+100 Ibs well for Steve Lochner, and he managed to lose

more weight than many other people using the

Lose It app.

The chart shows how Mr. Lochner compares with
other people who used the Lose It app for a year
and were trying to lose at least 50 pounds.

Some people lost over 100 pounds but others had
fluctuating weights and at least one person
gained 50 pounds.

+50

The more regularly someone tracks their weight
the better they seem to do. But no one can say in
advance who has what it takes to succeed as a
“Super Tracker.”

Starting Read more about tracking food and more in the
Weight rest of our Wired Well Special Section.

-50

-100

Steve Lothner

-150

-200 lbs
1 month 6 months 1 year 2 3 4 years

Check out https://www.nytimes.com/interactive/2015/11/17/health/wiredwell-food-diary-super-
tracker.html - beautiful storytelling using visualization and annotations.



https://www.nytimes.com/interactive/2015/11/17/health/wiredwell-food-diary-super-tracker.html
https://www.nytimes.com/interactive/2015/11/17/health/wiredwell-food-diary-super-tracker.html
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Relative Comparison

4 values

Unordered Unaligned
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Relative Comparison
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11 values Unordered Unaligned
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Heer and Bostock 2010 Crowdsourced Results
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Relative Comparison
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Relative Comparison

The problems with unaligned areas can be seen in stacked charts. A small
number of values is ok, but too many and nothing will be interpretable.
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Relative Comparison
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Relative Comparison

The problems with unaligned areas can be seen in stacked charts. A small
number of values is ok, but too many and nothing will be interpretable.
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Relative Comparison
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A) Known and Unknown Target Search

Random
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Target shown before hand (known) or not shown (unknown).
The unique colour here is the orange square.
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B) Subitizing (how many colours?)
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v

Grouped

v

Which grid has more colours?

Haroz S. and Whitney D., I[EEE TVCG 2012

How Capacity Limits of Attention Influence Information Visualization Effectiveness.
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A) Known and Unknown Target Search
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A) Known and Unknown Target Search
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Colour comparison Is even harder
when light/shadows are considered.
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Gestalt Laws
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HOW

We have to be careful when mapping
data to the visual world

We don’t see in 3D, and we have difficulties interpreting
information on the Z-axis.

62



2D always wins...

Thousands of points up/down and left/right

A

=

@
@Eﬁ

\\\\\\\\\H

We can only see the outside shell of the world

Our visual system is not good at interpreting information on
the z-axis.

*3D is normally only used for exploration of inherently 3D information, such as
medical imaging data...
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2D always wins...

Impedzance |S00kHz)

These options, taken randomly from google image searches so how widely 3D is abused in
information visualisation. All of these charts are manipulating our perception of the data by
using the Z axis to occlude information...it would be avoided in 2D.

= north
= south
Nea

N west
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2D always wins...

| Jet 1,
pt = 3.61 TeV

eta =0.32
phi = 0.64

Jet 2,

pt = 3.38 TeV
eta =-0.56
phi =-2.49

CMS Experiment at LHC, CERN ' |
Data recorded: Thu May 12 00:40:47 2016 EEST

Run/Event: 273158 / 238962455
Lumi section: 150

Dijet Mass: 7.7 TeV



D always wins...

Jet 1,

Jet 1, 0%1%6312%\,
pt = 3.61 TeV I

ota = 0.32 phi = 0.64

phi = 0.64

Jet 2, LT T,
pt = 3.38 TeV ’ /
eta =-0.56
phi =-2.49
Jet 2,
pt = 3.38 TeV
eta = -0.56
phi =-2.49
CMS Experiment at LHC, CERN | | CMS Experiment at LHC, CERN |
Data recorded: Thu May 12 00:40:47 2016 EEST Data recorded: Thu May 12 00:40:47 2016 EEST
Run/Event: 273158 / 238962455 Run/Event: 273158 / 238962455
Lumi section: 150 Lumi section: 150
Dijet Mass: 7.7 TeV Dijet Mass: 7.7 TeV
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2D always wins...

CMS Preliminary
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3D hides information. Is there anything behind the large bars? We'll never know.
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http://cms-results.web.cern.ch/cms-results/public-results/preliminary-results/BPH-14-008/index.html

2D always wins...

OHLC Q1 2009

3D is totally useless in this example. It only makes the nearest points look bigger, and
the further away points smaller than they are.

Image from https:/Mww.teraplot.com/financial
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HOW

We have to be careful when mapping
data to the visual world

Colour
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Colour
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Colour

The simplest, yet most abused of all visual encodings.

SANFORD AND SELNICK

Too—

m g Estimated fraction of precipitation
lost to evapotranspiration 1971-2000

T , 0.0-0.09 I 05-059 [ 1.0-1.09
I 0.1-0.19 |l o6-0.69 [ 1.1-1.19

I 0.3-0.39 0.8 - 0.89

Estimated fraction of precipitation ‘ - 0.4-0.49 0.9-0.99

lost to evapotranspiration 1971-2000
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B 02-0.20 N 0.7-079 [ 12-129
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B o4-049 [  ]09-099

FIGURE 13. Estimated Mean Annual Ratio of Actual Evapotranspiration (ET) to Precipitation (P) for the Conterminous U.S. for the Period
1971-2000. Estimates are based on the regression equation in Table 1 that includes land cover. Calculations of ET/P were made first at the
800-m resolution of the PRISM climate data. The mean values for the counties (shown) were then calculated by averaging the 800-m values
within each county. Areas with fractions >1 are agricultural counties that either import surface water or mine deep groundwater.

T 0

The problem is that a smooth step in a value does not equate to a
smooth colour transition...
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Colour

Additionally, colour is not equally binned in reality. We perceive
colours differently due to an increased sensitivity to the yellow part
of the spectrum...
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Colour

Luminosity is also not stable across the colours, meaning some colours

will pop out more than others... and not always intentionally.

Lt

L* plot for ROYGBIV colormap
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https://mycarta.wordpress.com/2012/10/06/the-rainbow-is-deadlong-live-the-rainbow-part-3/
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Colour

Luminosity is also not stable across the colours, meaning some colours
will pop out more than others... and not always intentionally.

Lt

L* plot for ROYGBIV colormap
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Colour
And how we perceive changes in hue is also very different.

8

6
E Gregory compared the
> wavelength of light

3 with the smallest

observable difference
iNn hue (expressed as
wavelength
difference).

As you can see, the
1 A 1 ! N ine is not flat.

400 500 600 700
wavelength of light (nm)

/3

Copyright: Richard L. Gregory - Eye and Brain - Princeton University Press - used with permission



Is there a colour palette for scientific visualisation
that works?
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Colour
HSL linear L rainbow palette

https://mycarta.wordpress.com/2012/10/06/the-rainbow-is-deadlong-live-the-rainbow-part-3/

Kindlmann, G. Reinhard, E. and Creem, S., 2002, Face-based Luminance Matching for Perceptual Colormap
Generation, IEEE Proceedings of the conference on Visualization '02 75



Colour
HSL linear L rainbow palette

These are available in matplotlib and therefore in seaborn, etc, so
there's no excuse )

/6



Colour

There are also lots of default colour maps that can be applied to

particular data types.

Binary

[ ]

Diverging

5 <
Binary

10 +1

Diverging

-1 0 +1

Diverging

Diverging

-1 0 +1

Categorical
N
Y s LI
b I R S TFA
TFA Categorical
3 S
2 g
1 g
Diverging
S
<
D)
S
[ 1S 1
-1 0 +1
Sequential
3 g
2 g
| §
255075

http://colorbrewer2.org/
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Color

Here I'm showing the correlation between football player attributes.
Is the choice of colour map helping this comparison?
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Color

Here I'm showing the correlation between football player attributes.
Is the choice of colour map helping this comparison?
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Color

Here I'm showing the correlation between football player attributes.
Is the choice of colour map helping this comparison?
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Color

Here I'm showing the correlation between football player attributes.
Is the choice of colour map helping this comparison?
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Color

Here I'm showing the correlation between football player attributes.
Is the choice of colour map helping this comparison?
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Color

You also don't want to have too many colours.

Too many colours means that users have to remember what a colour
means. So a max of around 8 categories in a plot is recommended,
otherwise the ‘distance’ between colours becomes too small.
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Way too many...and
the colours get
reused.

Nationality
Portugal
Argentina
Brazil
Uruguay
Germany
Spain
Poland
Wales
Sweden
Belgium
Croatia
France
Chile
Italy
Czech Republic
Slovenia
Colombia
Gabon
Netherlands
Austria
Armenia
England
Costa Rica
Denmark
Bosnia Herzegovina
Greece
Slovakia
Algeria
Serbia
Morocco

Here 10
colours are
being used to
represent 29
countries.
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Nationality

Portugal
Argentina
Brazil
Uruguay
Germany
Spain
Peland
Wales

Much better

Here 8 colours
are being used
to represent 8
countries.
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Color

Semantic relevance

Or just consistency

When there are many colours for example, we find it
difficult to remember abstract associations.
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Color
What are semantically resonant colours?

Fruits A E Vegetables A E
Apple - . Carrot . .
Banana . Celery .

Blueberry . . Corn .

Cherry . . Eggplant . .
Grape - . Mushroom .

Peach Olive .
Tangerine . . Tomato . .
Drinks A E Brands A E
A&W Root Beer . - Apple .
Coca-Cola . . AT&T . .
Dr. Pepper . - Home Depot . .
Pepsi B Kodak [ ]

Sprite . . Starbucks . .
Sunkist . . Target . .
Welch's Grape - . Yahoo! . .

Figure 6: Color assignments for categorical values in Ex-
periment 1. (A = Algorithm, E = Expert)

Selecting Semantically-Resonant Colors for Data Visualization
Sharon Lin, Julie Fortuna, Chinmay Kulkarni, Maureen Stone, Jeffrey Heer
Computer Graphics Forum (Proc. EuroVis), 2013
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Color

Semantic colouring is a good idea In theory,
but there are limited areas where this really

works.

But, If you are going to use colour, try to think how you
can make It easier for users to decode the colour to the

category without constantly having to look up a legend.
That way, the decoding time Is less.

Saving time...reducing cognitive load.

85



